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If you need assistance é 

Technical Support:  
Monday through Friday  

Phone  Support : 9:00 a.m. to 5:00 p.m. EST 

E-mail  Support: 9:00 a.m. to 8:00 p.m. EST  

Phone: toll free 877 -2-LAWGIC (252 -9442) or 904 -223 -2223  

Email  address: support@lawgic.com  

Fax: 904 -223 -2224  

FAQôs and Videoôs: www.lawgic.com  

mailto:support@lawgic.com
http://www.lawgic.com/
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Chapter 1:  About This Guide  and 

Getting Assistance  
 

This userôs manual will guide you through the creation of a document using the 

Lawgic software. It is a summary of the more extensive System Help within the 

Lawgic software available by selecting Help on the Lawgic menu and then Help 

again.  

 
If after reading this guide and creating a document you have further question s, we 

provide a number of additional resources as described in the óGetting Help in Using 

the Softwareô section below.  If all else fails, you can call or email us at the 

numbers listed in the óContacting Technical Supportô section below. 

 

Conventions Used  in This Guide  
 
¶ Menu or button commands will be given in Bold  Face (Example: ñClick the Start  

button.ò) 

¶ Important information on how to use the program is indicated by a

 

symbol.  

¶ A note will be indicated by a symbol.  
 

Getting Help  Using the Software  
 
To help you get the most out of your Lawgic subscription, we provide the following 

tools:  

 

Product Training Videos: We highly recommend you review the Product Training 

videos available on our web site at www.lawgic.com .  Click the Support  link and 

then the Training  link where you can DOWNLOAD the file to your computer.  The 
videos are also available on CD by request.  

 

If you still require additional training after reviewing the Product video and th is 

Getting Started Guide, call or email us at support@lawgic.com  to schedule a live 

telephone training session, limited to 1 hour per firm.  

 
General System Help is available from within the Lawgic product by click ing Help 

on the Lawgic menu and then Help  again.  This displays a table of contents on the 

left side of the screen that enables you to quickly access the help topics you need. 

Scroll to and click the appropriate category or topic. This action will display either 

the text of an explanation or a list of subordinate help topics, one or more of which 

may provide the information you need.  
 

 

http://www.lawgic.com/
mailto:support@lawgic.com
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Important!   In order to ensure proper document formatting 

and before creating your first docum ent, we highly 

recommend you review the Editing Your Documents topics for 

Word or WordPerfect available in System Help by clicking Help 
on the Lawgic menu inside the program and then Help again.  

 

Title - specific Help Resources is available by clicking Reso urces on the Help 

menu bar.  This displays a list of various primary source and supporting materials 

that relate to your specific product(s). These Resource  materials include:  

 
¶ Quick Start Guide  

¶ Update Letters  

¶ Product Outline  

¶ Key court decisions  

¶ Relevant s tatutes and regulations  

 
The program allows you to quickly view the text of these Resources  and, if you 

wish, to print them. All of these Resources  can be searched electronically.   

 

Estate planning products only:  óHow Toô Help is available by selecting óHow Toô 

from Question 1 (Select An Activity).  It includes numerous topics, such as how to 

create various trusts on death, how to customize documents and how to create 

templates.  
 

In addition to general system Help and title -specific Help Resources, you ca n also 

click About Our Authors  on the Help menu to display biographies of the authors 

of the program Titles.  Also, click License Agreement  on the Help menu to 

display the License Agreement  of the program.  

 
You can also access a list of Frequently Asked Qu estions (FAQs) by selecting 

Support and then Frequently Asked Questions from our web site at 

www.lawgic.com .  

 

Contacting Technical Support  
 
¶ Telephone:  You can call our Technical Support staff toll free at 877 - 2 - LAWGI C 

(252 - 9442) or 1 - 904 -223 - 2223 Mon day through Friday 9:00 a.m. ï 5:00 

p.m. Eastern Time. (You may leave voice mail  or send an email  at other hours.)  
 

¶ Fax:  1-904 -223 -2224 Address your fax to "Technical Support."  

 

¶ Mailing Address:  

 

Lawgic LLC  
Technical Suppo rt Department  

4745 Sutton Park Ct.  

#404  

Jacksonville, Florida 32224  

 

http://www.lawgic.com/
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¶ Email:  Our email address is support@lawgic.com .  We encourage the use of 

email especially if you have a more substantive legal, estate planning or 

program question as this will help expedite your answer.  

 
¶ Lawgicôs Web Site:  Visit our home page at http://www.lawgic.com/ .  

 

Whether you fax, e -mail, or write to us, please include your day or evening phone 

number s, the best time to return your call, and your FAX number or e -mail address, 

if available.  

mailto:support@lawgic.com
http://www.lawgic.com/
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Chapter 2:  Getting Started  
 
 

Please refer to the installation document provided as part of your subscription.   

Installation instructions were either emailed to y ou if you chose to download the 

product from our web site or they were sent to you if we mailed you a CD.  

 

1.  To begin, click Start , click Programs , select the  Lawgic  program group, then 
click Lawgic . The Select Title/File  dialog box is displayed (see Figure 2-1).  

 

 

Figure 2 - 1 :  

Select 

Title/File 
dialog box  

  

 

 

  

 

 

 

¶ New  begins a new answer file in the Title you select.  

¶ Files  lets you open one of your previously saved answer files.  
¶ Templates  loads a ñtemplate,ò which is an answer file you can create for 

reusable scenarios. The advantages of templates are explained in Chapter 9: 

Creating Templates.  

 
 

 

Important!   Answers are saved in an answer file.  Typically 

you create one answer file per client.  The program creates 

multiple d ocuments from one answer file.  Your answers are 
shared across all documents, which decreases errors and 

ensures consistency.  

 

2.  To begin answering questions, click New at the Select Title/File box, which  

begins a new answer file, not a document.  This will  take you to the Title page 

for that Title ( see Figure 2 -2).  The Title Page displays the name of the productôs 
author.  
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Figure 2 - 2:  

The Title Page.  

  

 

 

 
 

 

 

 

3.  Click the Start  button to go to Question 1 ( see Figure 2 -3) .  This screen displays 

a list of the activities available in the Title.  Select the activity you want to 

perform.   

 

Figure 2 - 3:  

Question 1 ï 

Select An 

Activity  
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4.  Click the Continue  button.  (You can also press Ctrl+Down 

Arrow  on your keyboard.)     
 
 

 

Important!   The Continue button takes you to the next 

unanswered, relevant question based on your prior answers.  

It is the only way to proceed through the questions in order to 

create a document.  

 

5.  This takes you to a sub -menu rela ting to your answer choice at Question 1.  
(See Figure 2 -4).  Make your selection and click the Continue button.  

 

Figure 

2 - 4:  

Trusts 

menu  

  

 

 

 
 

 

 

 

 

 

 

Important!   The program will always re -present the 

Title Page, Question  1 and any sub - menu relating to 

your choice at Question 1 whenever you open the 

answer file or when you return to it from the word 
processor.  Simply click the Continue button to proceed.  

 

6.  Before you go any further be sure to save your answers by selectin g Save or 

Save As from the File menu. The Save As  function allows you to also enter a 

Description.  See Chapter 5: Saving Your Answer Files  for more detailed 

information.  
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7.  To create your first document, simply click the Continue button and answer all 

of th e questions presented until you see the óAll Questions Answeredô screen 

(Figure 2 -5 below)  at the end of the Q & A process.  (See the following Chapters 
3-8 for details on how to navigate, review and save your answers).  

 

 

Figure 2 - 5:  

All Questions 

Answered  
dialog box  

  

 

 

 
 

 

 

 

8. At the óAll Questions Answeredô screen, select óSend to Word Processor.ô  The 

program will create and name the document and then send it to your word 
processor where you can make edits.  You must then name and save the docum ent 

in your word processor.  (See Chapter 7, Creating Your Document).  
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Chapter 3:  Understanding the  

Program Window Layout  
 

 

The program window is divided into 3 sub -windows (see Figure 3 -1):  

 

¶ The Navigator Window appears along the left side of the scr een.  This window 

displays an outline of the Title, indicating which questions will be or have been 
asked. A red checkmark indicates that you have already provided an answer for 

that question.  

 

¶ The Question Window  is located at the top right section of the  screen. This 

window displays the full text of the current question and your answer.  

 
¶ The Folders Window (with tabs that display different views) , located at 

the bottom right hand side of the screen.  Clicking on the various tabs allows 

you to view either Law & Strategy relating to the current question, Notes  that 

you may record about the current question, Question Help  on how to answer 

the current question, or Progress  (dynamic text based on your answers).  

 

 

Figure 3 - 1:  The 

program w indow 

showing the 

three  separate 

sub - windows  

  

 

 

  
  

 
Each window can be resized by dragging the border.  Move your mouse over the 

border until a double -headed arrow appears, then hold down the left mouse button 

and drag the border to the desired position.  
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The Navigato r Window  
 

The Navigator Window  (Figure 3 -2) is located on the left side of the screen. This 

window displays an outline of the Title, indicating which questions will be or have 
been asked. A red checkmark indicates that you have already provided an answer 

for that question.  See Chapter 8 , Navigating and Reviewing Your Answers  for 

additional information on the Navigator.  

 

 

Figure 3 - 2 :  

The Navigator 
window  

  

 

 

  

  

 

Elements in the Navigator  can be used to help determine your progress through 

the Title :  

 

  

A checkmark indicates that you have already answered the question. If 

there is no checkmark, you have not yet answered the question.  

 

 

Click the Plus Sign to expand a section of the Navigator  and view an 
outline of questions contained in that secti on.  

 

  Click the Minus Sign to collapse a section of the Navigator's  outline.  
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Bold  
 If a question appears in bold, you have previously flagged this  

 question for later use.  

Highlighted   The current question appears highlighted  in the Navigator . 

Italics   If a question appears in italics, you have marked it tentative.  

Red  
 If a question appears in red, its answer is required before the  

 intended  question can be presented.  

Green  
 If a question appears in green text, it contai ns notes in the Notes  

 folder.  

Gray  
 If a question appears grayed out, it is not relevant based on other  

 answers you've provided.  

 
 

 

Important!   Some questions require that certain threshold 

questions first be answered. For e xample, to answer questions 

about minor children in a Marital Settlement Agreement, you 

must specify that the couple has such children. This is called a 

threshold question. If you try to bypass a threshold question 

using the Navigator, the program will aut omatically jump to 
the threshold question.  When this happens, the threshold 

question appears in red on the Navigator.  

 

The Question Window  
 

The Question Window  (Figure 3 -3) is located in the top right section of the 

screen. This window displays the full text of the current question, relevant choices 

(if any), and your answer.  
 

Figure 3 - 3:  The 

Question window  
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Hereôs a quick overview of the elements in the Question Window :  

 

 
 

 

Flag this question for later use by clicking the Flag  icon in 

the bottom left of the Question Window .  When clicked, 

the Flag  icon changes color to red.  

 

 
 

 

Mark this question tentative by clicking the  Tentative  icon in 

the bottom left of the Question Window .   At the end of 

the Q&A process, a óTentative Answersô box will pop up to 

remind you that you have tentative answers.  

 

 

Takes you back to the last question you viewed.  

 

 

 

Takes you to the next relevant unanswered  question.  

 

 

Takes you to the next relevant question, whether or not it 

has already been answered.  

 

To toggle between Continue  and Review , click the arrow to 
the right of the Continue/Review  button and select the 

desired mode.  

 

 

 

The Folders Window  
 

The Folders Window contains four folders that display different type s of 

information to help you as you proceed through the questions and answer session.  

If a folderôs tab does not have a red check mark, the current question does not 
contain that type of information.  

 

Progress Folder  
Clicking the Progress  tab in the Folde rs Window  opens the Progress Folder , 

which shows dynamic text based on your answers (see Figure 3 -4).   
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Figure 3 - 4:  

Progress Folder  

  

 

 

  

  

 

As you proceed through the questions, the program will build a document based on 

your answers. Th e Progress Folder  allows you to read the text of the section, 

clause, or document that is affected by your answer to the current question.  

 

Law & Strategy Folder  
Clicking the Law & Strategy  tab in the Folders Window  opens the Law & 

Strategy Folder , which d isplays the federal and state  legal analysis of a question 
written by the Titleôs authors. (See Figure 3 -5).   

 

Figure 3 - 5:    

Law & 

Strategy 

Folder  

  

 

 

  

  

 

This analysis, which may vary depending on your facts, addresses issues such as:  

 

¶ Statutes,  regulations, or court decisions that could affect your answer  

¶ Legal ramifications of alternative approaches  

¶ Relevant practice considerations  

 
 
 










































